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Tennis Day is February
23.

Tennis started in France
in the 12th century with
the ball being struck by
the hand; rackets came
into use around the 16th
century.

There are three major
surfaces on which people
play tennis—hardcourt,
grass and clay.

Kings Henry V and Henry
VIl promoted the game of
tennis in England while
young monarchs.

William Shakespeare
mentioned “tennis balles”
in the play, “Henry V.
There are four major or
“Grand Slam”
professional tournaments
each year: Australian
Open (Jan), French Open
(May), Wimbledon (July)
and the US Open (Sept)
USTA (United States
Tennis Association)
sponsors leagues and
tournaments for adults
and juniors year-round.
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Tech Briefing by Jake Nonnemaker:
Network Security: The Citadel Defense (Pt 2)

In December’s newsletter, I shared the first
part of how AXICOM has created The Citadel
Defense for our clients, based on the idea of
multiple layers of defense, as was the case in
medieval times in terms of defense of a castle
or citadel. In this second part, the rest of the
AXICOM defense layers and tactics are
outlined.

. Active antivirus is the next defense
layer. AXICOM installs fast and lightweight
Webroot antivirus on all computers, servers,
and laptops. The antivirus Our network
operations center (NOC) is notified
immediately if a virus is detected or even
suspected.

. AXICOM-developed security policies
are the next layer in your defense. Our
security policies exceed those of the credit
card industry and Department of Defense.
These policies include stringent password and
software installation policies but also data
backup systems and two-factor authentication
for webmail systems and social networking

platforms.
. AxiBlock is an email security defense
system which protects users from phishing
scams and virus laden emails. Users receive
clean email in their inbox. Each user also
receives a daily list of quarantined email for
review.
. Desktop PCs, laptops and servers are
further protected with the AxiGuard defense
system. This lightweight agent ensures that the
security patches for Windows, Adobe, Flash,
Java and other software is always up to date.
Plus,
AxiGuard
performs
daily scans
for malicious
spyware then g
gives the PC a
performance
tune-up each
night. The
computers health is continuously reported back
to AXICOM’s network operation center.
(Continued on page 2)

Tips for Using Microsoft Outlook 2010

Outlook is still one of the most commonly
used email programs by businesses
throughout the United States. Here are some
handy tips for using Outlook 2010.

Insert a Screenshot
If you’d like to insert an image from your
desktop, begin writing your message, click on

the Insert tab on the Ribbon then click
Screenshot. A tiny dialog box shows you all
the current windows open so that you can
choose or click on Screen Clipping and click
to draw a box on the screen. Press Enter and
the contents will be inserted into your
message.
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Network Security: The Citadel Defense, Pt 2 (cont.)

(Continued from page 1)

. We defend your data by backing it up via two
distinct methods each day. Data is backed up onsite to
local storage and offsite to the cloud. A report is
delivered to the AXICOM tech team each day with the
backup status. If your data gets encrypted and held
ransom, your data can be quickly restored without
paying the cyber-criminals a nickel.

*  User education is the last line of defense. Through

printed and email newsletters, blogs, Facebook, and

other social media, AXICOM educates our clients

about proper computer security practices and cyber
dangers. AXICOM will also be adding videos to our

website.

Cyber-criminals are continuously developing
new methods and tools to breach your defenses.
A breach can cause severe downtime, financial
loss and damage to your business’ reputation.
As the defender of your citadel, AXICOM is
working continuously to keep the cyber-
barbarians at bay.

This is a well-designed and very effective system
that has served our clients extremely well over
the years. Call AXICOM if you have any
questions about your network security at
818.865.9865.

Microsoft Outlook 2010 Tips (cont.)

(Continued from page 1)

Recall your Message

We’ve all been there. You just sent an email and
wish you hadn’t—had the wrong info, sent it to the
wrong person, had the wrong tone, etc. Earlier
versions of OQutlook included the ability to recall
an already-sent message only if you and the
recipient were connected to a Microsoft Exchange
server. Now, Outlook 2010 extends that ability to
anyone who uses Outlook. The success of that
recall depends on the settings in the recipient’s
version of Outlook but it’s worth a try. To use this
feature, open the message in your Sent Items
folder, choose File, Info, click the Message Resend
and Recall and follow the prompts. Outlook will
try to report back to you on the success or failure
of the resend or recall.

Empty Outlook 2010’s Trash on Exit

It can be daunting to see hundreds of messages

piled up in your Deleted Items folder. To delete them
immediately, click on the File menu, Options,
Advanced, and find the Outlook Start and Exit
section. Add a checkbox next to Empty Deleted
Items folder when exiting Outlook.

Categorize by Color

To differentiate your emails in order to better
prioritize your time, you can rename categories by
going to the Home tab. In the Tags group, click
Categorize, then click All Categories. In the dialog
that appears, select a color name and click Rename.

Flag Outgoing Messages

Need to follow up on an email? While writing a
message you can create a reminder for yourself to
follow up on the message later. With the message
editor window open, go to the Ribbon’s Message tab,
and in the Tags group, click Follow Up. From the
dropdown menu, select a time for the follow-up.

Paddle Tennis—adapted from tennis; smaller court, no doubles lanes, lower net; use solid

paddle and depressurized tennis ball

Pickleball—combines elements of badminton, tennis and table tennis; same size court as
paddle tennis; uses solid paddle and a perforated polymer ball like a wiffle ball

Beach Tennis—combines elements of beach volleyball and tennis; uses a beach volleyball
court, uses a standard tennis racquet or paddle and a slightly depressurized tennis ball
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Add-Ins Give Microsoft Office a New Life

Are you looking for a way to change up your Mi-
crosoft Office experience? It’s actually pretty easy
to do thanks to a plethora of add-ins available for
Yyour favorite Office application. While these tools
aren’t exactly reinventing the wheel, they do add a
nifty wrinkle to the popular Office suite. Want
more information? Read on for everything you
need to know about add-ins, including which ones
you should consider installing.

And, just to note—the terms Add-in, Add-on, Plug-
In and Extension are all essentially the same
thing—a program that runs inside of or augments
another program.

Using Add-Ins

You probably use Microsoft Office on a daily basis
but, if you aren’t utilizing plug-ins, you are missing
out on a world of cool features that can improve
your favorite applications. Microsoft calls them
Office Add-ins, and they can be found in the Office
Store. Log into your Microsoft account and down-
load the Office Add-ins you want. (See box below
for alternative option.) After that, open the Office
application the add-in is meant for. Once open, go
to Insert > My Add-ins, and then pick the one you
want. That’s it.

Of course, knowing how to do it is just the first step
of the equation. You also have to know which add-
ins are worth installing. If you are using Office 2013
or later, here are some of the add-ins you might
want to check out.

People Graph
For: Excel
Price: Free

Excel is a great way to share numbers and vital da-
ta. However, your traditional spreadsheet can look
a bit boring, and in particular it can fall short if you
need certain figures to stand out. Apart from mak-
ing them bold or larger, there aren’t a ton of op-
tions at your disposal. This is where People Graph
comes in. This add-in lets you take those simple
numbers and transform them into an engaging info-
graphic that lets the data really stand out.

DocuSign
For: Word
Price: Free Trial (subscription required after trial)

If you need to sign a lot of documents, the process can
be a complicated one. DocuSign removes all the has-
sles by letting you drag and drop your eSignature
right there in Word. No longer will you have to print
out a document, sign it, and then scan it back onto the
computer. DocuSign also meets all legal standards
when it comes to eSignatures, so security or validity
won’t be an issue.

Translator
For: Word
Price: Free

If you work with bilingual clients, or simply want to
quickly translate some text into another language, it
normally involves a lot of copying and pasting from
Word to an internet browser and back again. The
Translator add-in cuts out the middle man, and lets
you perform translations in over 40 languages right
there in Word. While we can’t always vouch for the
accuracy of the translations, it can at least help you
get the gist of the message.

Believe it or not, there are tons of tools, tips and tricks
out there that will let you and your employees get
more out of Microsoft Office. Let our expert team
show you how your company can get the most out of
them and other Office features.

Published with permission from TechAdvisory.org.
Source.

How to add an Add-in for MS Office from
open document:

Open either Word or Excel and then in the
Ribbon, click on Insert tab and then choose
“Store” in the Apps box. Search for the add-
in and then click on that icon.
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Computer Network and Management Solutions
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Ask us about our fixed price service agreements and kick off

February 2016 the new year with computer support at a flat monthly fee you
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can budget for just like rent!

Westlake Village, CA 91362
(818) 865-9865
support@axicom.net

Play Tennis on February 23! AXiG U O rd

Our printed newsletters are always
available online! Check it out at

www.AXICOM.net

Inquiring Minds...

Tennis: How Technology Has Changed the
Sport

As with many sports, technology has impacted tennis. For
professional matches, the Hawkeye system has made for
much greater accuracy in »

calling lines and is able to :

override a linesperson’s

call. It definitely has '
helped reduced players’
rages. Would John
McEnroe have been the same if Hawkeye existed? We
can only speculate. There are also racquet sensors that
will provide information like the amount of power, spin,
impact location, number of shots, ball speed and live

T “You’ve got to get to the stage

in life where going for it is more

Sony Sensor Zapp

important than winning or
losing:— Arthur Ashe

L

www.AXICOM.net.

tracking. Some Babolat racquets have the sensors already
integrated in the racquet while others can be purchased
separately and added to the bottom of the handle such as
the Sony Sensor or the Zepp. Prices for sensors range from
$90 to $200.

New Year’s Resolutions from a Geek’s
Perspective

Tech New Year's Resolutions

. Delete all my email and start the.year afresh.

. Install a battery backup as soon.as the first
winter power outage occurs.

. Blow out the dust.and mouse nest from my PC.
. Renew my antivirus and Maxim subscriptions.

. Clean my smartphone and get a fresh-case;
What the heck justbuy a new iPhone. -

. Review LinkedIn profile and update it with
embellished achievements.

. Organize the cables under my desk;
oh, look, a skittle!

. Tweet something profound for a change.
. Preemptively unfriend Facebook people who
I think are going to complain about the

seasonal Starbucks cup design.

10. Sulk and brood about what a failure last
years New Year's resolutions were.
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